
GETTING STARTED GUIDE

NI PXIe-5644R
6 GHz Reconfigurable RF Vector Signal Transceiver

Note  Before you begin, install and configure your chassis and controller.

This document explains how to install, configure, and test the NI 5644R. The NI 5644R is an
RF vector signal transceiver (VST), and ships with the following software options, which you
use to program the device.
• NI-RFmx driver software
• NI-RFSA and NI-RFSG driver software
• NI LabVIEW Instrument Design Libraries for Vector Signal Transceivers (instrument

design libraries)

Caution  The protection provided by this equipment may be impaired if it is used
in a manner not described in the documentation.
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Electromagnetic Compatibility Guidelines
This product was tested and complies with the regulatory requirements and limits for
electromagnetic compatibility (EMC) stated in the product specifications. These requirements
and limits provide reasonable protection against harmful interference when the product is
operated in the intended operational electromagnetic environment.

This product is intended for use in industrial locations. However, harmful interference may
occur in some installations, when the product is connected to a peripheral device or test object,
or if the product is used in residential or commercial areas. To minimize interference with
radio and television reception and prevent unacceptable performance degradation, install and
use this product in strict accordance with the instructions in the product documentation.

Furthermore, any changes or modifications to the product not expressly approved by National
Instruments could void your authority to operate it under your local regulatory rules.

Caution  To ensure the specified EMC performance, operate this product only with
shielded cables and accessories.

Caution  To ensure the specified EMC performance, operate this product only with
cables less than 3 meters in length.

Verifying the System Requirements
To use the NI 5644R, your system must meet certain requirements. For more information
about minimum system requirements, recommended system, and supported application
development environments (ADEs), refer to the readme, which is available on the software
media or online at ni.com/updates.

Unpacking the Kit
Caution  To prevent electrostatic discharge (ESD) from damaging the device,
ground yourself using a grounding strap or by holding a grounded object, such as
your computer chassis.

1. Touch the antistatic package to a metal part of the computer chassis.
2. Remove the device from the package and inspect the device for loose components or any

other sign of damage.

Caution  Never touch the exposed pins of connectors.
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Caution  Do not disconnect the cable that connects CAL IN to CAL OUT.
Removing the cable from or tampering with the CAL IN or CAL OUT front
panel connectors voids the product calibration and specifications are no longer
warranted.

Note  Do not install a device if it appears damaged in any way.

3. Unpack any other items and documentation from the kit.

Store the device in the antistatic package when the device is not in use.

Preparing the Environment
Ensure that the environment you are using the NI 5644R in meets the following specifications.

Operating ambient temperature
(IEC 60068-2-1, IEC 60068-2-2)

0 °C to 55 °C

Operating relative humidity
(IEC 60068-2-56)

10% to 90%, noncondensing

Maximum altitude 2,000 m (800 mbar) (at 25 °C ambient
temperature)

Pollution Degree 2

Indoor use only.

Caution  Clean the hardware with a soft, nonmetallic brush or lint free cloth. Make
sure that the hardware is completely dry and free from contaminants before
returning it to service.

Note  Refer to the NI PXIe-5644R Specifications at ni.com/manuals for complete
specifications.
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Verifying the Kit Contents
Figure 1. NI 5644R Kit Contents
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1. NI PXIe-5644R Module
2. Screwdriver, Part Number 772006-01
3. SMA Driver Bit, Part Number 780895-01
4. Driver Software DVD

5. Read Me First: Safety and Electromagnetic
Compatibility

6. Maintain Forced-Air Cooling Note to Users
7. NI PXIe-5644R Getting Started Guide

Other Equipment
There are several required items not included in your device kit that you need to operate the
NI 5644R. Your application may require additional items not included in your kit to install or
operate your device.

Required Items

• A PXI Express chassis and chassis documentation. The NI PXIe-1075 chassis is one
available option for your PXI Express device. For more information about compatible
chassis options, visit ni.com/info and enter the Info Code pxiechassis.

• A PXI Express embedded controller or PC with MXI controller system that meets the
system requirements specified in this guide and chassis documentation.

Optional Items

• PXI Chassis Slot Blocker kit (NI part number 199198-01)
• SMA (m)-to-SMA (m) cables
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Choosing and Installing the Software

Software Options
NI provides three software options for programming the NI 5644R—NI-RFmx, NI-RFSA and
NI-RFSG instrument driver software, and the instrument design libraries.
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Table 1. NI 5644R Software Options

Software
Option

Description Use Case

   NI-RFmx Provides a single-handle instrument
driver with built-in measurements.

You can use instrument driver
FPGA extensions to customize the
device FPGA using precompiled
bitfiles.

Use NI-RFmx SpecAn to perform
spectral measurements.

Use NI-RFmx Demod to perform
modulation quality measurements,
such as EVM.

Use NI-RFmx cellular personalities to
perform physical layer measurement
analysis on supported cellular signals.

NI-RFSA and
NI-RFSG
instrument
driver

The NI-RFSA and NI-RFSG APIs
each provide a fixed API for
interacting with your NI 5644R
device.

NI-RFSA and NI-RFSG provide
standard IVI-based functionality
needed for most vector signal
analyzer and vector signal generator
applications.

You can use NI-RFSA and
NI-RFSG instrument driver FPGA
extensions to customize the device
FPGA using precompiled bitfiles.

Use NI-RFSA to create custom
measurements or applications that
require I/Q data.

Use NI-RFSG to generate continuous
or modulated waveforms.

Use NI-RFSA and NI-RFSG with the
NI Modulation Toolkit to develop
software-defined radio transmitters
and receivers.

Use NI-RFSG with the NI Modulation
Toolkit to create and generate
modulated signals to test receivers.

Instrument
design
libraries

The instrument design libraries
allow you to customize your
NI 5644R device to suit the needs of
your application.

Sample projects, which allow you to
take common measurements with
your device, are included with the
installation.

Use the instrument design libraries
with the LabVIEW FPGA Module to
customize the behavior of the device
FPGA to create application-specific
instrument designs.

Note  You can use either NI-RFmx or NI-RFSA and NI-RFSG instrument driver
software in combination with the instrument design libraries in a single application;
however, only one software option can access the device at a time.

Related Information
Refer to the NI RF Vector Signal Analyzers Help or the NI RF Signal Generators Help for
more information about using the NI-RFSA and NI-RFSG instrument driver FPGA extensions.
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Comparison of Software Features
NI-RFmx, NI-RFSA and NI-RFSG instrument driver software, and the instrument design
libraries vary in the features they support.

Table 2. Comparison of Software Features

Feature NI-RFmx NI-RFSA and
NI-RFSG

Instrument Design Libraries

    Customization of
onboard FPGA

Supported
using the
instrument
driver FPGA
extensions

Supported using
the instrument
driver FPGA
extensions

Supported using the LabVIEW
FPGA Module

Source availability Closed source Closed source Open source

LabVIEW support Yes Yes Yes

Microsoft .NET
support

Yes Yes No

RF Standards Toolkits
support

No Yes Additional programming
required for integration.

NI-RFSA and
NI-RFSG Soft Front
Panels support

Yes Yes Yes

LabVIEW examples or
sample projects

Includes
LabVIEW
examples

Includes
LabVIEW
examples

Includes LabVIEW sample
projects, with additional
examples available at
ni.com/vstgettingstarted.

Installing the Software
You must be an Administrator to install NI software on your computer.
1. Install NI LabVIEW.
2. (Recommended) Install NI LabVIEW FPGA Module.

Note  Installation of the LabVIEW FPGA Module is required to customize the
behavior of the device FPGA if you are using the instrument design libraries.

3. (Optional) Install NI LabVIEW Real-Time Module.
4. (Recommended) Install the latest service pack for LabVIEW and any LabVIEW modules

you are using.
5. Insert the driver software media into your computer. The installer should open

automatically.
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If the installation window does not appear, navigate to the drive, double-click it, and
double-click autorun.exe.

6. Follow the instructions in the installation prompts.

Note  Windows users may see access and security messages during
installation. Accept the prompts to complete the installation.

Note  The default installation installs NI LabVIEW Instrument Design
Libraries for Vector Signal Transceivers, NI-RFmx, NI-RFSA, and NI-RFSG.

7. When the installer completes, select Restart in the dialog box that prompts you to restart,
shut down, or restart later.

Installing the NI 5644R
Caution  To prevent damage to the NI 5644R caused by ESD or contamination,
handle the module using the edges or the metal bracket.

You must install the software before installing the hardware.

Before you install the hardware, refer to the guidelines in the Maintain Forced-Air Cooling
Note to Users included with the module to ensure that the device can cool itself effectively.
This document is also available at ni.com/manuals.

The NI 5644R is a three-slot module with two backplane connectors. The module must be
installed into three adjacent chassis slots, and the left two slots must be PXI Express
compatible.
1. Ensure the AC power source is connected to the chassis before installing the module.

The AC power cord grounds the chassis and protects it from electrical damage while you
install the module.

2. Power off the chassis.
3. Inspect the slot pins on the chassis backplane for any bends or damage prior to

installation. Do not install a module if the backplane is damaged.
4. If the chassis has multiple fan speed settings, ensure the fans are set to the highest setting.

Note  Inadequate air circulation could cause the temperature inside the chassis
to rise above the optimal operating temperature for the device, potentially
causing thermal shutdown, shorter lifespans, or improper performance.

5. Position the chassis so that inlet and outlet vents are not obstructed.

Caution  Do not disconnect the cable that connects CAL IN to CAL OUT.
Removing the cable from or tampering with the CAL IN or CAL OUT front
panel connectors voids the product calibration and specifications are no longer
warranted.

6. Remove the black plastic covers from all the captive screws on the module front panel.
7. Identify a supported slot in the chassis. The following figure shows the symbols that

indicate the slot types.
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Figure 2. Chassis Compatibility Symbols
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1. PXI Express System Controller Slot
2. PXI Peripheral Slot
3. PXI Express Hybrid Peripheral Slot

4. PXI Express System Timing Slot
5. PXI Express Peripheral Slot

The NI 5644R can be placed in PXI Express peripheral slots, PXI Express Hybrid
peripheral slots, or PXI Express system timing slots.

8. Touch any metal part of the chassis to discharge static electricity.
9. Ensure that the ejector handle is in the unlatched (downward) position.
10. Hold the module by the edges and slide it into the empty compatible slots. Ensure the

base engages with the guides in the chassis.

Figure 3.  NI 5644R Module Installation
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NI PXIe-5644R

Vector Signal Transceiver

65 MHz - 6.0 GHz

1. PXI Express Chassis
2. NI PXIe-5644R Module
3. Ejector Handle in Down Position

11. Latch the module in place by pulling up on the ejector handle.
12. Secure the module front panel to the chassis using the front-panel mounting screws.

Note  Tightening the top and bottom mounting screws increases mechanical
stability and also electrically connects the front panel to the chassis, which can
improve the signal quality and electromagnetic performance.

13. Cover all empty slots using filler panels or fill using slot blockers to maximize cooling air
flow.
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14. Power on the chassis.

Direct Connections to the NI 5644R
The NI 5644R is a precision RF instrument that is sensitive to ESD and transients. Ensure you
take the following precautions when making direct connections to the NI 5644R to avoid
damaging the device.

Caution  Apply external signals only while the NI 5644R is powered on. Applying
external signals while the device is powered off may cause damage.

• Ensure you are properly grounded when manipulating cables or antennas connected to the
NI 5644R RF IN connector.

• If you are using nonisolated devices, such as a nonisolated RF antenna, ensure the
devices are maintained in a static-free environment.

• If you are using an active device, such as a preamplifier or switch routed to the NI 5644R
RF IN connector, ensure that the device cannot generate signal transients greater than the
RF and DC specifications of the NI 5644R RF IN connector.
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Hardware Front Panel Connectors and Indicators
Figure 4. NI 5644R Front Panel
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Caution  Apply external signals only while the NI 5644R is powered on. Applying
external signals while the device is powered off may cause damage.

Table 3. Device Front Panel Icon Definitions

Refer to the user documentation for required maintenance measures to ensure user
safety and/or preserve the specified EMC performance.

The signal pins of this product's input/output ports can be damaged if subjected to
ESD. To prevent damage, turn off power to the product before connecting cables and
employ industry-standard ESD prevention measures during installation, maintenance,
and operation.

Table 4. NI 5644R General Front Panel Connectors

Connector Use

  REF IN Input terminal that allows for the use of an external 10 MHz Reference
Clock.

REF OUT Output terminal that can export a 10 MHz Reference Clock or the 120 MHz
Sample Clock.

PFI 0 Programmable-function digital I/O (DIO) connector for use with triggers or
events.

DIGITAL I/O DIO terminal that contains general-purpose 3.3 V LVTTL DIO signals. DIO
lines are direction-configurable as input or output.

Table 5. NI 5644R RF Front Panel Connectors

Connector Use

  RF IN 0 RF IN Input terminal for RF signals.

CAL IN Caution  Do not disconnect the cable that connects
CAL IN to CAL OUT. Removing the cable from or
tampering with the CAL IN or CAL OUT front panel
connectors voids the product calibration and
specifications are no longer warranted.

Terminal that is used when running self-calibration on the device.

LO OUT Output terminal for exporting the RF IN 0 LO source.

LO IN Input terminal that allows the use of an external LO for RF IN 0.
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Table 5. NI 5644R RF Front Panel Connectors (Continued)

Connector Use

  RF OUT 0 RF OUT Output terminal for RF signals.

CAL OUT Caution  Do not disconnect the cable that connects
CAL IN to CAL OUT. Removing the cable from or
tampering with the CAL IN or CAL OUT front panel
connectors voids the product calibration and
specifications are no longer warranted.

Connector that is used when running self-calibration on the device.

LO OUT Output terminal for exporting the RF OUT 0 LO source.

LO IN Input terminal that allows for the use of an external LO for
RF OUT 0.
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Table 6. NI 5644R Front Panel LEDs

LED Indications

  ACCESS Indicates the basic hardware status of the device.

Off—The device is not yet functional or has detected a problem with a PXI
Express power rail.

Amber—The device is being accessed. Accessed means that you are writing to the
device setup registers to control the device, reading from the device to monitor
the device status, or transferring data to/from the device.

Green—The device is controllable through the software.

ACTIVE The device behavior is programmable using the instrument design libraries and
the LabVIEW FPGA Module. If no behavior is defined, the LED will be OFF.

When using NI-RFSA and NI-RFSG, the ACTIVE LED indicates the state of the
device.

Off—The device is idle.

Solid green—The device is generating a waveform.

Dim amber—The device is waiting for an acquisition Reference Trigger.

Solid amber—The device is acquiring a waveform.

Solid red—The device has detected an error. The LED remains red until the error
condition is removed.

Note  The indicators are listed in increasing order of priority. For
example, if you are generating a waveform using NI-RFSG and
waiting on an acquisition Reference Trigger in NI-RFSA, the LED is
dim amber.

Related Information
Refer to your device specifications document for more information about front panel
connectors and LEDs.

Configuring the Hardware in MAX
Use Measurement & Automation Explorer (MAX) to configure your National Instruments
hardware. MAX informs other programs about which devices reside in the system and how
they are configured. MAX is automatically installed with the instrument design libraries and
NI-RFSA and NI-RFSG.
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1. Launch MAX by navigating to Start»All Programs»National Instruments»NI MAX or
by clicking the NI MAX desktop icon.

2. In the Configuration pane, double-click Devices and Interfaces to see the list of installed
devices. Installed devices appear under the name of their associated chassis.

3. Expand your Chassis tree item.

MAX lists all devices installed in the chassis. NI 5644R devices appear as NI-RIO
devices in the list. Your default device names may vary.

Note  If you do not see your hardware listed, refer to the Troubleshooting
section of this document.

4. Record the device identifier MAX assigns to the hardware. Use this identifier when
programming the NI 5644R.

Caution  When you install, uninstall, or move an NI-RIO device in your
system, resource identification of your NI-RIO devices may change. Whenever
any of these changes occur, verify resource identification of all your NI-RIO
devices in MAX, and, if necessary, make changes to your software and
documentation.

Self-Calibration
Self-calibration adjusts the NI 5644R for variations in the module environment using an
onboard high-precision calibration tone. Perform a complete self-calibration after first
installing your module and letting it warm up for 30 minutes.

Note  Warm up begins when the PXI Express chassis has been powered on and the
operating system has completely loaded.

The NI 5644R modules are externally calibrated at the factory; however, you should perform a
self-calibration in any of the following situations:
• After first installing the NI 5644R into your chassis
• After any module in the chassis is installed, uninstalled, or moved
• When the system is in an environment where the ambient temperature varies or the

module temperature has drifted more than ±5 °C from the temperature at the last self-
calibration

• To periodically adjust for small performance drifts that occur with product aging

NI recommends you perform the self-calibration from the installed self-calibration executable
located at Start»All Programs»National Instruments»Vector Signal Transceivers»VST
Self Calibrate. When using LabVIEW, you can also use the niVST Self-Calibrate VI, located
on the Functions»Instrument I/O»Instrument Drivers»NI VST Calibration palette.

Related Information
Refer to the NI RF Vector Signal Transceivers Help for more information about self-
calibration and self-calibrating in text-based languages.
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Locating the Software and Examples

Software Locations

Table 7. Location of NI 5644R Software Options

Software
Option

ADE Location

   NI-RFmx LabVIEW Available on the LabVIEW Functions palette at
Measurement I/O»NI-RFmx.

LabWindows/CVI NI-RFmx functions are available from the
LabWindows/CVI Library menu at Library»RFmx
SpecAn Library and Library»RFmx Demod
Library.

Microsoft Visual C/C++ Use the header files located in the <NIDir>\Shared
\ExternalCompilerSupport\C\include
directory and import library files located in one of the
following directories:
• Windows 10 (32-bit)/8.1 (32-bit)/7 (32-bit)—

<NIDir>\Shared
\ExternalCompilerSupport\C\include

• Windows 10 (64-bit)/8.1 (64-bit)/7 (64-bit):
– 32-bit installation—<NIDir>\Shared

\ExternalCompilerSupport\C
\lib32\msvc

– 64-bit installation—<NIDir>\Shared
\ExternalCompilerSupport\C
\lib64\msvc

where <NIDir> is one of the following locations:
• Windows 10 (32-bit)/8.1 (32-bit)/7 (32-bit)—

Program Files\National Instruments
• Windows 10 (64-bit)/8.1 (64-bit)/7 (64-bit)—

Program Files (x86)\National
Instruments

Microsoft .NET For the location of .NET class libraries, refer to the
installed NI-RFmx readme.
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Table 7. Location of NI 5644R Software Options (Continued)

Software
Option

ADE Location

   NI-RFSA LabVIEW Available on the LabVIEW Functions palette at
Measurement I/O»NI-RFSA.

LabWindows/CVI Available in the <IVIROOTDIR32>\Drivers
\niRFSA directory, where <IVIROOTDIR32> is one
of the following locations:
• Windows 10 (32-bit)/8.1 (32-bit)/7 (32-bit)—

Program Files\IVI Foundation\IVI
• Windows 10 (64-bit)/8.1 (64-bit)/7 (64-bit)—

Program Files (x86)\IVI Foundation
\IVI

Microsoft Visual C/C++ Use the header files located in the <IVIROOTDIR32>
\Include directory and import library files located
in the <IVIROOTDIR32>\Lib directory, where
<IVIROOTDIR32> is one of the following
directories:
• Windows 10 (32-bit)/8.1 (32-bit)/7 (32-bit)—

Program Files\IVI Foundation\IVI
• Windows 10 (64-bit)/8.1 (64-bit)/7 (64-bit)—

Program Files (x86)\IVI Foundation
\IVI

Microsoft .NET To use the .NET API, you must install the .NET class
libraries. For download and installed file locations,
visit ni.com/info and enter Info Code
NETAPIdriversupport.
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Table 7. Location of NI 5644R Software Options (Continued)

Software
Option

ADE Location

   NI-RFSG LabVIEW Available on the LabVIEW Functions palette at
Measurement I/O»NI-RFSG.

LabWindows/CVI Available in the <IVIROOTDIR32>\Drivers
\niRFSG directory, where <IVIROOTDIR32> is one
of the following locations:
• Windows 10 (32-bit)/8.1 (32-bit)/7 (32-bit)—

Program Files\IVI Foundation\IVI
• Windows 10 (64-bit)/8.1 (64-bit)/7 (64-bit)—

Program Files (x86)\IVI Foundation
\IVI

Microsoft Visual C/C++ Use the header files located in the <IVIROOTDIR32>
\Include directory and import library files located
in the <IVIROOTDIR32>\Lib directory, where
<IVIROOTDIR32> is one of the following
directories:
• Windows 10 (32-bit)/8.1 (32-bit)/7 (32-bit)—

Program Files\IVI Foundation\IVI
• Windows 10 (64-bit)/8.1 (64-bit)/7 (64-bit)—

Program Files (x86)\IVI Foundation
\IVI

Microsoft .NET To use the .NET API, you must install the .NET class
libraries. For download and installed file locations,
visit ni.com/info and enter Info Code
NETAPIdriversupport.

Instrument
design
libraries

LabVIEW Available in one of the following directories:
• Windows 10 (32-bit)/8.1 (32-bit)/7 (32-bit)—

Program Files\National Instruments
\LabVIEW 2014\instr.lib\RF-RIO

• Windows 10 (64-bit)/8.1 (64-bit)/7 (64-bit)—
Program Files(x86\National
Instruments\LabVIEW 2014\instr.lib
\RF-RIO
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Programming Examples Locations

Using the NI Example Finder
If you're using NI-RFmx, NI-RFSA, or NI-RFSG with LabVIEW or LabWindows/CVI, use
the NI Example Finder to locate programming examples.
1. Launch LabVIEW or LabWindows/CVI.
2. Select Help»Find Examples to open the NI Example Finder.
3. Navigate to Hardware Input and Output»Modular Instruments.
4. Open the example that best matches your application requirements.

Using LabVIEW Sample Projects
If you're using the instrument design libraries, use the included LabVIEW sample projects to
begin programming the NI 5644R.
1. Launch LabVIEW.
2. In the New Project dialog box, select Sample Projects in the left pane.
3. Navigate to and open the project that best matches your application requirements.

Using Microsoft Visual C/C++
If you're using NI-RFmx or NI-RFSA with Microsoft Visual C/C++, locate examples in the
following directories.

Table 8. Location of Microsoft Visual C/C++ Programming Examples

Software Option Examples Location

  NI-RFmx <NIDocDir>\RFmx\Demod\Examples

<NIDocDir>\RFmx\SpecAn\Examples

where <NIDocDir> is the Users\Public\Public Documents
\National Instruments directory.

NI-RFSA <NIDocDir>\NI-RFSA\examples

where <NIDocDir> is the Users\Public\Public Documents
\National Instruments directory.
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NI 5644R First Measurement Options
You can verify proper installation and configuration of your device using the NI-RFSG Soft
Front Panel and NI-RFSA Soft Front Panel. Additionally, if you installed the instrument
design libraries, you can make a measurement using a LabVIEW sample project.

Making a Measurement with Soft Front Panels
Use the NI-RFSG Soft Front Panel and NI-RFSA Soft Front Panel to verify proper installation
and configuration of the NI 5644R hardware.
1. Connect the RF IN port to the RF OUT port using an SMA (m)-to-SMA (m) cable.

Caution  Do not disconnect the cable that connects CAL IN to CAL OUT.
Removing the cable from or tampering with the CAL IN or CAL OUT front
panel connectors voids the product calibration and specifications are no longer
warranted.

2. Select Start»All Programs»National Instruments»NI-RFSG»NI-RFSG Soft Front
Panel to launch the NI-RFSG Soft Front Panel.

3. Select the device identifier assigned to the NI 5644R in MAX in the Device drop-down
menu.

4. Click the RF On/Off button to generate a 1 GHz continuous wave (CW) tone RF signal
at the RF output terminal of your device.

5. Select Start»All Programs»National Instruments»NI-RFSA»NI-RFSA Soft Front
Panel to launch the NI-RFSA Soft Front Panel.

6. Select the device identifier assigned to the NI 5644R in MAX in the Device drop-down
menu.

7. Verify that the NI-RFSA Soft Front Panel is receiving the CW tone.
8. Close the NI-RFSA Soft Front Panel and NI-RFSG Soft Front Panel.

Related Information
Refer to the NI-RFSG Soft Front Panel Help for more information about using the NI-RFSG
Soft Front Panel.
Refer to the NI-RFSA Soft Front Panel Help for more information about using the NI-RFSA
Soft Front Panel.

Making a Measurement with a Sample Project
This measurement requires installation of the instrument design libraries.
1. Launch LabVIEW.
2. Select File»Create Project.
3. On the left side of the Create Project window, select Vector Signal Transceiver (VST).
4. On the right side of the Create Project window, select the Simple VSA and VSG

sample project for your device and click Next.
5. Specify a name and location for the project in the Create Project window and click OK.

LabVIEW creates, configures, and opens a new Simple VSA and VSG project.
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6. In the project tree, navigate to My Computer»Project Documentation, open Simple
VSA and VSG.html, and navigate to the Running this Sample Project section of the
documentation.

7. Follow the instructions in the project documentation for making the measurement.

Troubleshooting
If an issue persists after you complete a troubleshooting procedure, contact NI technical
support or visit ni.com/support.

Why Is the ACCESS LED Off When the Chassis Is
On?
The LEDs may not light until the device has been configured in MAX. Before proceeding,
verify that the NI 5644R appears in MAX.

If the ACCESS LED fails to light after you power on the chassis, a problem may exist with the
chassis power rails, a hardware module, or the LED.

Caution  Apply external signals only while the NI 5644R is powered on. Applying
external signals while the device is powered off may cause damage.

1. Disconnect any signals from the PXI Express module front panels.

Caution  Do not disconnect the cable that connects CAL IN to CAL OUT.
Removing the cable from or tampering with the CAL IN or CAL OUT front
panel connectors voids the product calibration and specifications are no longer
warranted.

2. Power off the PXI Express chassis.
3. Remove the module from the PXI Express chassis and inspect it for damage. Do not

reinstall a damaged device.
4. Install the module in a different PXI Express chassis slot from which you removed it.
5. Power on the PXI Express chassis.
6. Restart your computer.
7. Verify that the device appears in MAX.

What Should I Do if the NI 5644R Doesn't Appear in
MAX?
1. In the MAX configuration tree, expand Devices and Interfaces.
2. Expand the Chassis tree to see the list of installed hardware, and press <F5> to refresh

the list.
3. If the module is still not listed, power off the system, ensure that all hardware is correctly

installed, and restart the system.
4. Navigate to the Device Manager.
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Operating System Description

  Windows 10 Select Start»Control Panel»Device Manager.

Windows 8.1 Right-click the Start button, and select Device Manager.

Windows 7 Select Start»Control Panel»Device Manager.

5. If you are using a PXI controller, verify that a National Instruments entry appears in the
system device list. If error conditions appear in the list, right-click the NI PXIe-5644R
and NI-RIO FPGA Device nodes and select Update Driver. If you are using an MXI
controller, right-click PCI-to-PCI Bridge, and select Properties from the shortcut menu
to verify that the bridge is enabled.

6. Restart your computer.
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Where to Go Next
Refer to the following figure for information about other product tasks and associated
resources for those tasks.

*This item is also installed with the driver software.
 The VST device information is also located in the NI RF Vector Signal Analysis Help or the NI RF Signal Generators Help.

EXPLORE LEARN CREATE

DISCOVER

Learn LabVIEW Basics 

the application development
environment (ADE)
 for your application.

about hardware features 
or review device  

specifications.

custom applications with
an application programming

interface (API).

Instrument Design Libraries
Vector Signal Transceiver
Sample Projects*

NI-RFSA and NI-RFSG
Examples*

ni.com/vstgettingstarted

Services
ni.com/services

NI Community
ni.com/community

Support
ni.com/support

more about your products through ni.com. 

Located online at ni.com/manuals Located online at ni.com/gettingstarted

RF Solutions
ni.com/rf

NI PXIe-5644R
Specifications*

NI RF Vector Signal
Transceivers Help* †

†

Tip  The NI RF Vector Signal Transceivers Help is an HTML version of a
traditional user manual that includes detailed information about RF fundamentals,
device features, and programming with NI LabVIEW Instrument Design Libraries
for Vector Signal Transceivers.

Worldwide Support and Services
The NI website is your complete resource for technical support. At ni.com/support, you have
access to everything from troubleshooting and application development self-help resources to
email and phone assistance from NI Application Engineers.

Visit ni.com/services for NI Factory Installation Services, repairs, extended warranty, and
other services.
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Visit ni.com/register to register your NI product. Product registration facilitates technical
support and ensures that you receive important information updates from NI.

A Declaration of Conformity (DoC) is our claim of compliance with the Council of the
European Communities using the manufacturer’s declaration of conformity. This system
affords the user protection for electromagnetic compatibility (EMC) and product safety. You
can obtain the DoC for your product by visiting ni.com/certification. If your product supports
calibration, you can obtain the calibration certificate for your product at ni.com/calibration.

NI corporate headquarters is located at 11500 North Mopac Expressway, Austin, Texas,
78759-3504. NI also has offices located around the world. For telephone support in the United
States, create your service request at ni.com/support or dial 1 866 ASK MYNI (275 6964). For
telephone support outside the United States, visit the Worldwide Offices section of ni.com/
niglobal to access the branch office websites, which provide up-to-date contact information,
support phone numbers, email addresses, and current events.

Refer to the NI Trademarks and Logo Guidelines at ni.com/trademarks for information on NI trademarks. Other
product and company names mentioned herein are trademarks or trade names of their respective companies. For
patents covering NI products/technology, refer to the appropriate location: Help»Patents in your software, the
patents.txt file on your media, or the National Instruments Patent Notice at ni.com/patents. You can find
information about end-user license agreements (EULAs) and third-party legal notices in the readme file for your NI
product. Refer to the Export Compliance Information at ni.com/legal/export-compliance for the NI global trade
compliance policy and how to obtain relevant HTS codes, ECCNs, and other import/export data. NI MAKES NO
EXPRESS OR IMPLIED WARRANTIES AS TO THE ACCURACY OF THE INFORMATION CONTAINED HEREIN AND
SHALL NOT BE LIABLE FOR ANY ERRORS. U.S. Government Customers: The data contained in this manual was
developed at private expense and is subject to the applicable limited rights and restricted data rights as set forth in FAR
52.227-14, DFAR 252.227-7014, and DFAR 252.227-7015.
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